
1. Uvod u R
R je nastao početkom devedesetih kao implementacija programskog jezika S. Danas

je S implementiran kao programski paket S-PLUS. Iako postoje razlike u odnosu na R,
većina programa se jednako može izvršiti u oba sustava.

Instalacijski paket može se pronaći na adresi http://www.r-project.org/. Iako ova
instalacija omogućava sve funkcionalnosti R-a, dodatno se mogu koristiti praktičnija i
vizualno ugodnija okruženja kao što je primjerice RStudio. Instalacija se može pronaći
na https://www.rstudio.com/ (odabrati RStudio Desktop Open Source Edition).

Korisničko sučelje RStudia standardno je podijeljeno na četiri dijela: otvorene skripte
za upisivanje koda, povijest naredbi i memorija, konzola i output prozor u kojem se
prikazuju datoteke, slike, paketi i pomoć. Za osnovne funkcionalnosti grafičkog sučelja
pogledati https://www.rstudio.com/wp-content/uploads/2016/01/rstudio-IDE-cheatsheet.
pdf (dostupno i u izborniku na Help → Cheatsheets → RStudio IDE Cheat Sheet). Iz
istog dokumenta vrijedi zapamtiti nekoliko kratica:

• Ctrl+Enter – slanje naredbe iz skripte na izvršavanje u konzoli,

• Tab – izbor nadopunjavanja započete naredbe,

• Ctrl+Shift+C – komentiranje retka.

Popis svih kratica može se dobiti s Alt+Shift+K.
Od osnovih svojstava R sintakse treba napomenuti da je R osjetljiv na mala i velika

slova, a komentari započinju znakom #. Dozvoljeno je koristiti točku u imenovanju
varijabli i funkcija pa su riječi u nazivima često razdvojene točkom, primjerice funkcija
read.table().

1 Osnovne naredbe
R je kalkulator, upisivanje jednostavnih računskih naredbi odmah daje rezultat:�
2+2
exp (1 )� �

Help se poziva na nekoliko različitih načina. Help je standardno u obliku html datoteke
što omogućuje navigiranje između različitih dijelova. U RStudiu help će se prikazati u
donjem desnom dijelu sučelja, a za pozivanje helpa dovoljno je označiti ključnu riječ i
stisnuti F1.�
#poz ivan j e helpa
he lp ( " i f " )
? " i f "
?? histogram
? h i s t
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example ( h i s t )� �
Za učitavanje datoteka važno je definirati radni direktorij (working directory – wd) u

kojem se nalaze datoteke. Osim direktne naredbe, u RStudiu to je moguće napraviti putem
izbornika: u donjem desnom dijelu prozora na kartici Files odabrati željeni direktorij te
zatim na More→ Set As Working Directory. Drugi način je u glavnom izborniku otići na
Session→ Set Working Directory gdje se može odabrati direktorij ili jednostavno postaviti
na mjesto trenutno otvorene skripte.�
#p o s t a v l j a n j e d i r e k t o r i j a ( uob iča jeno Windows a d r e s i r a n j e d i r e k t o r i j a s \

ovdje j e s \\ i l i s / )
getwd ( )
setwd ( "C:\\ Users \\ Dan i j e l \\ Desktop \\ " )
getwd ( )
setwd ( "C: / Users / Dan i j e l /Desktop/ " )
getwd ( )� �

Sve varijable s kojima radimo, učitane su u radnu memoriju. Sljedećim naredbama se
može vidjeti njihov popis i obrisati neke ili sve. Operator <- je operator pridruživanja
i odgovara = ili := u drugim programskim jezicima. Može se koristiti i obratno, ->. U
RStudio <- se brzo dobije s Alt+-.�
#b r i s a n j e sv ih v a r i j a b l i i z memorije
x <− 0
0 −> x
l s ( ) #popis sv ih v a r i j a b l i u memori j i
rm( x )
rm( l i s t=l s ( ) )� �
2 Objekti u R-u i manipulacija

Objekt Različiti tipovi
podataka u
jednom objektu?

Objašnjenje

vector Ne Niz podataka istog tipa
factor Ne Kategorijalna varijabla
array Ne k-dimenzionalno polje podataka istog tipa
matrix Ne Specijalan slučaj array za k = 2
data frame Da Skup nekoliko vektora ili factora istog ili različitog

tipa
ts Ne Podaci vremenskog niza
list Da Lista objekata bilo kojeg tipa
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2.1 Vektori
Vektor je niz podataka istog tipa (numerički, znakovni...). Najčešće se zadaje funkcijom
c() – konkatenacija. Prilikom bilo kakvog pridruživanja u konzoli se ne prikazuje nikakav
ispis. Ukoliko želimo ispis, stavljamo naredbu u zagrade. Uobičajene operacije i funkcije
djeluju na vektore po komponentama.�
#Vektor
x <− c (1 , 4 , 5 , 2 , 3)
( x <− c (1 , 4 , 5 , 2 , 3) )
y <− c (2 , 3 , 1 , 9 , 4)
y
c (x , y )

exp ( x )
x∗y
x+y
x^2� �

Postoji nekoliko zgodnih načina kako možemo jednostavno zadati vektore, primjerice,
korištenjem operatora :, te funkcija seq i rep.
Funkcija seq može imati više argumenata (pogledati help) od kojih svaki ima svoje ime.
Općenito u R-u, kada pozivamo funkciju možemo argumente naznačiti navodeći ime ar-
gumenta = vrijednost argumenta, i u tom slučaju redoslijed nije bitan (npr. seq(from=1,
to=12, by=2) je isto kao i seq(to=12, from=1, by=2)). Ukoliko ne navodimo ime argu-
menta, tada je bitno da se vrijednosti argumenta predaju onim redoslijedom kako je to
definirano za funkciju (piše u helpu). Primjerice, prva tri argumenta funkcije seq su from,
to i by. Stoga je poziv seq(from=1,to=12,by=2) ekvivalentan pozivu seq(1,12,2). Ako
eventualno neki argument preskačemo (kad nije obavezan), onda za sve argumente poslije
tog moramo napisati njegovo ime.
Više naredbi može se zapisati u jednom retku ako se odvoje s ;.�
x <− 3 :10
( x <− seq ( from = 1 , to = 12 , by = 2) )
( x <− seq ( to = 12 , from = 1 , by = 2) )
( x <− seq (1 , 12 , 2) )
seq (1 , 10 , l ength = 7)
rep ( 1 : 4 , 2) ; rep ( 1 : 4 , 1 : 4 ) ; rep ( 1 : 4 , each=3)� �

Osim numeričkih važni su i tzv. logički vektori i znakovni vektori.�
#Log i čk i v e k t o r i
( x <− 4 : 9 )
mode( x )
vek1 <− x>5
vek1
mode( vek1 )
y <− c (0 , 3 , 6 , 7 , 10 , 11)
( vek2 <− x==y )
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vek1 & vek2
vek1 | vek2

#v e k t o r i znakova
( znakovi <− c ( "d " , " 3 " , "R" , " v " ) )
mode( znakovi )� �

Elementi vektora dohvaćaju se indeksima unutar uglatih zagrada. Negativan indeks
daje vektor bez tog elementa. Indeks može biti i vektor koji sadrži redne brojeve elemenata
koji će biti dohvaćeni. Posebno korisna je mogućnost indeksiranja logičkim vektorom iste
duljine. Na taj način moguće je dohvaćati elemente na osnovu logičkih uvjeta.�
#I n d e k s i r a n j e vektora
l ength ( x )
x <− 1 :20
x [ 3 : 1 5 ]
x [−5]
x [ 1 : 1 0 ] [ − 5 ]
x [ seq (1 , l ength ( x ) , 2) ]
x [ x<=5]� �
2.2 Faktori
Faktori predstavljaju poseban tip namijenjen kategorijalnim varijablama koje mogu poprim-
iti konačno mnogo različitih vrijednosti. Korisnost ovog tipa dolazi do izražaja pri statis-
tičkoj analizi podataka.�
#Neka j e x vektor podataka o spo lu u kojima 0 označava muški i 1 ž en sk i

spo l
x <− c (1 , 0 , 0 , 1 , 1 , 1 , 0 , 1)
f a c t o r ( x )
( x . f <− f a c t o r (x , l a b e l s = c ( "M" , "Ž" ) ) ) #r e d o s l i j e d k a t e g o r i j a odgovara

numeričkom r e d o s l i j e d u� �
2.3 Matrice
Matrica se može zadati spajanjem vektora kao retke – rbind() (row bind) ili spajanjem
vektora kao stupce – cbind() (column bind). Funkcija t() vrši transponiranje matrice.
Drugi način zadavanja matrice je funkcijom matrix().�
#Matrice
rbind ( 1 : 4 , 1 : 4 )
cbind ( 1 : 4 , 1 : 4 )
t ( cbind ( 1 : 4 , 1 : 4 ) )

matrix ( data = 1 :15 , nrow = 5 , nco l = 3)
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matrix ( data = 1 :15 , nrow = 5 , nco l = 3 , byrow = TRUE)
matrix (8 , 2 , 3)
matrix ( 1 : 6 , nrow = 2)

diag (1 , 3)
diag ( c (4 , 5) )� �

Standardne matrične operacije:�
#Matrične o p e r a c i j e
(A <− matrix ( 1 : 1 6 , 4 , 4 , byrow = TRUE) )
(B <− matrix ( 1 6 : 1 , 4 , 4 , byrow = TRUE) )
A∗B
A %∗% B
diag (A)

A <− matrix ( rnorm (16 , 0 , 1) , 4 , 4)
x <− 1 :4
b <− A %∗% x
s o l v e (A, b)
inve r z <− s o l v e (A)
inve r z %∗% A� �

Dohvaćanje elemenata matrice obavlja se zadavanjem dva indeksa odvojena zarezom
unutar uglatih zagrada. Prvi indeks označava redak, a drugi stupac. Ako jedan od indeksa
nije naveden, ispisuje se cijeli redak ili cijeli stupac. Redci i stupci matrice mogu se
proizvoljno imenovati. Osim toga matrice se mogu mijenjati unutar ugrađenog tabličnog
editora.�
#I n d e k s i r a n j e elemenata matr ice
(A <− matrix ( 1 : 1 2 , nrow = 3 , byrow = TRUE) )
A[ 2 , 3 ]
A[ 2 , ]
A[2 :3 , −1 ]

dim(A)

rownames (A) <− c ( " a " , "b " , " c " )
A
data . entry (A)
A� �
2.4 Ostali tipovi objekata
Data frame je objekt najsličniji tablici podataka s kakvima se susrećemo u statističkim
analizama. Za razliku od matrice, stupci mogu biti različitih tipova (osim numerički,
stupci mogu biti znakovni ili faktori). Pri tome, svaki stupac ima svoj naziv. Podaci koji
se učitavaju obično se spremaju u data frame.
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Lista je niz objekata bilo kojeg tipa. Primjerice, lista može sadržavati i listu. Većina pro-
cedura kao rezultat daje listu iz koje se onda dohvaćaju podaci. Elementi liste dohvaćaju
se operatorom $ (djelomično odgovara . u nekim objektno orijentiranim jezicima).�
#Os ta l i t i p o v i objekata
l i s t a <− l i s t ( x = c (1 , 2 , 3) , y = c (5 , 6) , z = l i s t ( a = 2 , b = 9) )
l i s t a $x
l i s t a $x [ 2 ]
l i s t a $z
l i s t a $z$b� �

Osim numeričkih, znakovnih i faktor podataka postoje i neki specijalni kao što su: Inf
– beskonačno, NaN – Not A Number, NA – Not Available (missing value – nedostajuća
vrijednost).�
#Posebne v r i j e d n o s t i
i s . f i n i t e ( p i )
i s . f i n i t e ( I n f )
?NaN
i s . nan (NaN)
?NA
i s . na (NA)
i s . na ( 1 : 1 0 )
i s . na ( c (1 , 2 , 3 , NA, NA, 2) )� �
2.5 Kontrola toka i petlje
Sintaksa osnovnih naredbi za kontrolu toka i petlji:�
#If , f o r i f u n k c i j e
x <− 5
i f (x<=6) p r i n t ( " manji " ) e l s e p r i n t ( " v e ć i " )
i f (x<=6) { p r i n t ( " manji " ) ; p r i n t ( " s tvarno manji " ) } e l s e p r i n t ( " v e ć i " )

x <− 0
f o r ( i in 1 : 10 ) {
x <− x + i
}
x

zbro j <− f unc t i on (a , b) {
re turn ( a + b)
}

zbro j ( 2 , 3 )� �
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3 R paketi
Bogatstvo R-a leži u preko 13000 paketa koji se jednostavno instaliraju i sadrže gotove pro-
cedure za brojne statističke probleme. Pokretanjem se učitava oko 20 paketa, a svi ostali
se instaliraju i učitavaju po potrebi. Instalacija i učitavanje može se izvršiti naredbama:�
#I n s t a l i r a n j e i u č i t avan j e paketa
i n s t a l l . packages ( " optimx " )
l i b r a r y ( " optimx " )� �

Putem izbornika u RStudiu, pakete je moguće instalirati na Tools→ Install Packages.

4 Učitavanje podataka
Podaci koji se učitavaju mogu biti u različitim formatima, primjerice .txt, .csv, .dat, .xls...

Tekstualne datoteke formata txt mogu se učitavati funkcijom read.table. Prije toga
treba postaviti radni direktorij na mjesto gdje se datoteka nalazi. Važne opcije funkcije
read.table su: header koja označava ima li datoteka prvi redak u kojem su zapisani nazivi
stupaca. Ako su podaci iz Excela, tada je obično decimalna oznaka zarez, a ne točka kao
u R-u, pa to treba naglasiti stavljanjem dec=",". Objekt koji dobijemo učitavanjem je
data frame. Kad su podaci učitani, važno je provjeriti da je sve kako treba funkcijom str.
Funkcijom str može se vidjeti ako neki podaci eventualno nisu učitani kao numerički a
trebali bi biti. To bi se dogodilo primjerice ako propustimo postaviti dec=",".�
#Učitavanje podataka
getwd ( )
L ign je <− read . t ab l e ( f i l e = " l i g n j e . txt " , header = TRUE, dec = " , " )
L ign je
s t r ( L ign je ) #s t r u c t u r e
names ( L ign je )
dim( L ign je )� �

Funkcija read.table može učitavati podatke i iz drugih tipova datoteka, primjerice csv
(comma separated values). Kraći oblik u ovom slučaju omogućen je funkcijom read.csv2
koja će po defaultu koristiti zarez kao decimalnu oznaku i ; kao sep argument (default
vrijednost za sep je prazan prostor). Sljedeći pozivi su ekvivalentni:�
hormon <− read . csv2 ( ’ hormon . csv ’ )
s t r ( hormon )
hormon1 <− read . t ab l e ( ’ hormon . csv ’ , header = TRUE, dec = " , " , sep = " ; " )
s t r ( hormon1 )
hormon2 <− read . t ab l e ( ’ hormon . txt ’ , header = TRUE, dec = " , " , sep = " \ t " )
s t r ( hormon2 )� �

Podaci koje želimo analizirati najčešće su spremljeni u obliku jedne Excel tablice.
Takve je podatke moguće učitati direktno iz Excela (vidjeti primjerice paket "xlsx" ili
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"xlsReadWrite"): Uobičajeno se podaci učitavaju indirektno tako da se najprije spreme u
csv formatu. Prije toga, prvo treba pripremiti Excel datoteku. Ako su nazivi u prvom
retku (header), ti nazivi ne smiju sadržavati hrvatske dijakritičke znakove i ne smiju biti
neka ključna riječ (npr. data je ključna riječ). Zatim u Excelu, idemo na Save As i kao
tip odaberemo CSV (MS-DOS). Tako dobivenu datoteku možemo učitati u R kao csv.

U RStudiu učitavanje se može obaviti i putem glavnog izbornika na File → Import
Dataset, odabrati datoteku i eventualno korigirati parametre učitavanja. Isto je moguće i
u gornjem desnom dijelu klikom na Import Dataset. Novije verzije RStudia omogućavaju
i direktno učitavanje iz Excela.

Nakon učitavanja, podaci se spremaju u tip data.frame. Stupcu dobivenog data framea
pristupa se operatorom $, a svaki stupac je vektor čijim elementima pristupamo indeksir-
anjem s uglatim zagradama. Svi stupci se mogu učitati u memoriju tako da ime stupca
postane ime varijable. Pri tome treba biti pažljiv jer to može prebrisati neku staru vari-
jablu istog imena.�
#pr i s tupan j e ucitanim podacima
Lign je $GSI
GSI
attach ( L ign je )
GSI
detach ( L ign j e )
GSI
attach ( L ign je )

#s o r t i r a n j e podataka
L ign je [ order ( Mjesec ) , ]
L ign j e

#snimanje podataka
LignjeM <− Lign je [ Spol==1, ]
wr i t e . t ab l e ( LignjeM , f i l e = " LignjeM . txt " , sep = " \ t " , quote = FALSE,

append = FALSE, na = "NA" )� �
5 Grafika u R-u
Osnovni grafički paket koji se učitava pokretanjem R-a je graphics. Osim njega, postoje
i neki drugi kao što su lattice ili ggplot. Grafičke funkcije dijele se u osnovne skupine:

• High-level funkcije koje daju kompletan graf

• Low-level funkcije koje služe dodavanju elemenata na postojeći graf dobiven pozivom
high-level funkcije

• Funkcije za interaktivan rad s grafom

Osnovna grafička funkcija je plot(). To je generička funkcija, što znači da kao ulazne
varijable može primati razne vrste objekata.

8



Dobivene slike lako se spremaju u druge oblike. Mogu se spremiti korištenjem odgo-
varajućih funkcija pdf(), jpeg(), png(), odnosno direktno u RStudiu korištenjem Export
u donjem desnom dijelu ili izbornika Plots → Save as Image.�
#Graf ika u R−u
pre s su r e
s t r ( p r e s su r e )
p l o t ( p r e s su r e )
p l o t ( p r e s su r e $ temperature , p r e s su r e $ p r e s su r e )
p l o t ( p r e s su r e ~ temperature , data = pre s su r e )

pdf ( " s l 1 . pdf " , width = 7 , he ight = 5)
p l o t ( p r e s su r e ~ temperature , data = pre s su r e )
dev . o f f ( )� �

Opća sintaksa funkcije plot je oblika plot(x,y) gdje je x vektor x-koordinata točaka,
a y vektor y-koordinata točaka. Točke će biti spojene ako to odredimo odgovarajućim
atributom. Osnovni atributi funkcije plot:

• type – osnovni izgled grafa, za točke p, za linije l itd. (pogledati help: ?plot)

• lwd – debljina linije ako je tip l

• lty - tip linije, npr. dashed za isprekidanu

• col – boja grafa (boja se može zadati na razne načine, osnovne boje su dostupne
kao engleske riječi, za ostale može se koristiti funkcija rgb)

• main – glavni naziv grafa

• sub – podnaslov

• xlab, ylab – naziv x, y osi

• xlim, ylim – granice koje određuju koliki dio x i y osi će biti prikazan

Svaki od ovih atributa je opcionalan i služi uređivanju grafa ako nismo zadovoljni stan-
dardnim postavkama.�
p lo t ( p r e s su r e $ temperature , p r e s su r e $ pres sure , type = " l " , lwd = 1 . 2 , l t y =

" dashed " , c o l = " red " , main = " Glavni nas lov " , sub = " Podnaslov " , xlab =
" temperatura " , ylab = " t l a k " , asp = 0 . 2 )

x <− 1 :20
y <− rnorm (20 , 5 , 1)
p l o t (x , y , main = " Naziv g ra f a " , x lab = " Naziv x−o s i " , y lab = " Naziv y−o s i "

, xl im = c (0 , 22) , yl im = c (0 , 10) , type = "p" )
p l o t (x , y , main = " Naziv g ra f a " , x lab = " Naziv x−o s i " , y lab = " Naziv y−o s i "

, xl im = c (0 , 22) , yl im = c (0 , 10) , type = "b" )
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p lo t (x , y , main = " Naziv g ra f a " , x lab = " Naziv x−o s i " , y lab = " Naziv y−o s i "
, xl im = c (0 , 22) , yl im = c (0 , 10) , type = " o " , pch = 22 , c o l = " red " ,
bg = " ye l low " , cex = 2)� �
Funkcija plot je high-level funkcija i njome dobivamo jedan graf i uređujemo okvir slike,

nazive i sl. Sve druge grafove dodajemo low-level funkcijama. Osnovne takve funkcije su
points() za točke, abline() za pravac, lines() za bilo kakvu liniju, legend() za legendu itd.�
#Dodavanje drugih elemenata na g ra f
p l o t (x , y , main = " Naziv g ra f a " , x lab = " Naziv x−o s i " , y lab = " Naziv y−o s i "

, xl im = c (0 , 22) , yl im = c (0 , 10) , type = " o " )
po in t s (3 , 3)
a b l i n e (2 , 1)
l i n e s ( c (1 , 2 , 3) , c (5 , 5 , 4) , c o l = " red " )

p l o t (x , y , main = " Naziv g ra f a " , x lab = " Naziv x−o s i " , y lab = " Naziv y−o s i "
, xl im = c (0 , 22) , yl im = c (0 , 10) , type = " o " , pch = 22 , c o l = " red " ,
bg = " ye l low " , cex = 2)

a b l i n e (2 , 1 , c o l=" blue " )
legend ( " t o p l e f t " , l egend = c ( " Podaci " , " pravac " ) , c o l = c ( " red " , " b lue " ) ,

l t y = c (1 , 1) , lwd = c (2 , 2) ) #l t y=1 − s o l i d l i n e , lwd−d e b l j i n a l i n i j e

x <− seq (−3 , 3 , l ength = 100)
p l o t (x , x^2 , type = " l " , xaxt = "n " , yaxt = "n " , bty = "n" , l t y = " dashed " ,

c o l = " purple " , lwd = 2 , ylim = c (0 , 3) , y lab = " " )
l i n e s (x , abs ( x ) , type = " l " , xaxt = "n " , yaxt = "n " , bty = "n" , l t y = "

dotted " , c o l = " red " , lwd = 2)
ax i s (1 , pos = c (0 , 0) )
ax i s (2 , pos = c (0 , 0) , l a s = 2)
arrows (−2.5 , 1 , −2, 2 , lwd = 2 , l ength = 0 . 1 )
t ex t (−2.5 , 0 . 8 , l a b e l s = expr e s s i on ( f [ 1 ] ( x ) == group ( " | " , x , " | " ) ) )
arrows (2 , 1 , 1 . 5 , 1 .5^2 , lwd = 2 , l ength = 0 . 1 )
t ex t (2 , 0 . 8 , l a b e l s = expr e s s i on ( f [ 2 ] ( x ) == x^2) )� �

Funkcije zadane izrazima možemo jednostavno crtati funkcijom curve(). Funkcija
curve() za razliku od plot može primiti izraz kao argument, pa tako i crtati definirane
funkcije (default oznaka za argument je x).�
#Crtanje f u n k c i j a
curve ( x^2 , from = −2, to = 2)
curve ( x^2 , −2, 2)
curve ( t ^2 , −2, 2 , xname = " t " )

p l o t (−5:5 , (−5:5) ^2)
curve ( x^2 , −5, 5 , add = TRUE)� �
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6 Dodatne napomene vezane uz RStudio
U RStudiu moguće je vrlo jednostavno generirati izvještaje iz postojeće R skripte. Takav
izvještaj u sebi sadrži pripadni R kod i output koji se pri tome generira. Izvještaje je
moguće generirati kao Word, pdf ili html dokument. Nakon što u R skripti napravimo
analizu, iz izbornika odaberemo File→ Compile Report zatim odaberemo tip dokumenta
i kliknemo Compile. U R skriptama iz kojih generiramo izvještaj treba izbaciti naredbe
install.packages() koje mogu proizvesti probleme.

Zatvaranjem skripte, RStudio će automatski na lokaciji skripte snimiti i Rhistory
datoteku koja sadrži povijest korištenih naredbi. Ovu mogućnost moguće je isključiti na
Tools → Global Options → Always save history.

Zadatak 1. Sa web stranice kolegija preuzmite datoteku Baze.zip te pronađite bazu po-
dataka djelatnici.xls.

(a) Učitajte podatke u R.

(b) Odaberite podatke iz varijable placa_prije posebno za muškarce i žene.

(c) Odaberite podatke iz varijable placa_prije za muškarce sa srednjom stručnom spre-
mom.

(d) Odaberite podatke iz varijable placa_prije za muškarce sa srednjom ili visokom stručnom
spremom.

(e) Odaberite podatke iz varijabli placa_prije i placa_poslije za odjel IS.

(f) Nacrtajte graf parova podataka iz varijabli placa_prije i placa_poslije. Uredite graf.

(g) Nacrtajte prethodni graf tako da podatke za muškarce prikažete plavim točkama, a za
žene crvenim točkama. Dodajte legendu na graf.

�
#( a ) u č i t a t i poadtke putem i zbo rn ika
s t r ( d j e l a t n i c i )
attach ( d j e l a t n i c i )
#(b)
p laca_p r i j e [ spo l == "Z" ]
p laca_p r i j e [ spo l == "M" ]
#( c )
p laca_p r i j e [ spo l == "M" & obrazovanje == " SSS " ]
#(d)
p laca_p r i j e [ spo l == "M" & ( obrazovanje == " SSS " | obrazovanje == "VSS" ) ]
#( e )
d j e l a t n i c i [ o d j e l == " IS " , 7 : 8 ]
d j e l a t n i c i [ o d j e l == " IS " , c ( " p laca_p r i j e " , " p laca_p o s l i j e " ) ]

#( f )
p l o t ( p laca_p r i j e , p laca_p o s l i j e )
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p lo t ( p laca_p r i j e , p laca_p o s l i j e , x lab = " Plaća p r i j e " , y lab = " Plaća
p o s l i j e " , pch = 16)

#( g )
p l o t ( p laca_p r i j e [ spo l == "M" ] , p laca_p o s l i j e [ spo l == "M" ] , pch = 16 , c o l="

blue " )
po in t s ( p laca_p r i j e [ spo l == "Z" ] , p laca_p o s l i j e [ spo l == "Z" ] , pch = 16 , c o l=

" red " )
legend ( " t o p l e f t " , l egend = c ( " muškarci " , " žene " ) , c o l = c ( " blue " , " red " ) ,

pch = c (16 , 16) )� �
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